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Overview of PowerTeacher 
PowerTeacher provides access to the gradebook; to attendance information; to general 
student information, and to school reports. You can use PowerTeacher anywhere you 
have access to the Internet. Additional information is available through the help menu in 
PowerTeacher and on the SCS SIS site (http://www.scsk12.org/psinfo/index.html). 
 
Log in to PowerSchool Teacher 

• Open a Web browser, such as Safari or Firefox (Mac), or Internet Explorer 
(Windows), and enter the address of your PowerSchool server followed by 
/teachers in the browser address bar 

• Enter your username and password provided by the school administrator 
• Click Enter 
• To log off PowerTeacher, click Logout in the upper right corner 

 
The PowerTeacher Start Page consists of three areas: 

A- Navigation Bar – located at the top of the screen. The Navigation Bar provides   
access to the Start Page (via the PowerTeacher logo), the Report Queue, Online 
Help, and the Logout Button. 
B- Main Menu – located at the left side of the screen. The Main Menu provides 
access to the Start Page, the Daily Bulletin, the Staff Directory, the Gradebook, 
and Reports. 
C- Current Classes – located in the center of the Start Page screen. The Current 
Classes area provides access to information regarding the students in the 
classes you teach, as well as to the tools for attendance, and reports. 
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Using PowerTeacher in the Classroom 
You can use PowerTeacher on a daily basis to help you manage your students’ 
information. In PowerTeacher you can take attendance, look up staff email addresses, 
manage grades, and print reports. 
 
Daily Bulletin 
The first time a user logs on each day the Daily Bulletin will be displayed. The Daily 
Bulletin lists school and district information. 
 
Taking Attendance 

 
To take attendance in PowerTeacher, click the chair of the class for which you 
will be taking today’s attendance.  

 
 

A- Select the appropriate attendance code from the Current attendance code 
menu above student names to indicate which students are absent or tardy. 
B- Click the cell next to an absent or tardy student’s name to assign the 
appropriate code. To change codes, first select the appropriate code then click 
the cell next to the student’s name. 
C- Click Submit to save the attendance record. 

 
Note: If all of your students are present, you will still need to click the chair icon to open 
the attendance screen and click Submit to save the attendance information.  
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Accessing Student Information 
 

Click the backpack to view student pages. The PowerTeacher Student 
Information pages provide information about each student enrolled in your 
classes. All of the student pages are accessed in a similar manner. 

• From the PowerTeacher Start Page, click the backpack on the row of the class 
you would like to view. 

• Click a student’s name in the list on the left side of the page. Your default 
student page appears for the students you selected. At the bottom of the list of 
students, your other classes will be listed. You can switch class lists by clicking 
a different class name. 

• At the top of the student screen is individual student information: 
-Student Name 
-Student Grade Level 
-Student ID Number 
-School 
-Alert Symbols-Not all symbols will be used for every student, but many 
students will have at least one. Clicking on a symbol will provide details of the 
alert information. 

 Medical Caduceus- Medical Alert 

 Silhouette- Guardian Alert 

 Scales-Discipline Alert 

   Candle-Birthday Alert 

 Warning Triangle-Other alert 

 IEP Alert-IEP in effect 
To view other student information, choose a page from the Select Screens menu. 

 
 
 
 

 

-Cumulative Grade Information-displays the cumulative grade information for the 
selected student in high school courses 
-Demographics-displays demographic information on file for the selected student. 

 -Final Grade Entry (Citizenship)-location for entering citizenship grades 
-Final Grade Entry (Standards)-SCS does not currently use the Standards function 
-Meeting Attendance- displays the attendance to date for the selected student 

 -Net/Phone Access Summary-displays the access summary for the selected student 
and for the parents of the selected student 
 -Print a Report-displays the report dialogue. This works like the Reports feature 
available in the Main Menu but rather than printing the report for all students, the report is 
generated only for the selected student 
 -Quick Lookup-displays student grades and attendance 
 -Schedule-displays selected student’s schedule 
 -Standards-SCS does not currently use the Standards function 
 -Student Photo-SCS does not currently use the Student Photo function 
 -Submit Log Entry-your school administrator will provide you with information about this 
feature if your school chooses to use it 
 -Teacher Comments-comments should be entered through the Gradebook  
 -Term Grades-displays averages for each class the student was enrolled in for that term. 
Clicking on the average causes the score page to appear for that term 
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Entering Citizenship  
 
All teachers must assign Citizenship for each student in every class. Citizenship 
grades will be entered using the PowerTeacher Portal. A roster of students with 
pull down menus is displayed. Select the appropriate grade for each student and 
click Submit. Citizenship may be changed as often as needed. 

 
  
Seating Chart 

 
A seating chart for each class is available by selecting the student desk on the 
Start Page in PowerTeacher.  
• Select the Layout tab to begin 
• Select and arrange the furniture in Layout mode 
• To assign students to chairs select the Seat Assignment tab 
• To save click Submit on the Classroom Tools tab 

 
Note: Seat size affects only the seat not the tables or blocks. 
 
Alert Screen 

A list of alerts for each class can be accessed. School administrators enter 
these alerts. 
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Working with PowerTeacher Gradebook 
 
Launch the Gradebook in the PowerTeacher Portal 

 
• From the Start page, click Gradebook in the Main Menu. 
• On the PowerTeacher Gradebook Launch page, click 

Launch Gradebook.  
• As the program launches, a dialog box will appear asking you 

to “Trust” a certificate. Click Trust. 
• When you are ready to quit using the gradebook, navigate to 

the PowerTeacher Gradebook menu at the top of your 
computer screen, and click Quit PowerTeacher Gradebook, 
or simply click Close in the gradebook window. 

 
 

Notes: 
• Java 5 is required for PowerTeacher Gradebook. 
• If you attempt to open a second session of PowerTeacher Gradebook, a dialog box 

indicating that a PowerTeacher Gradebook session is already in use will open. You 
will be able to end the first session and continue logging in to the second session, or 
quit launching the second session. (This situation may arise when you have been 
working at school without quitting the gradebook; then you launch the gradebook at 
home on a different computer.) 

• If you have been logged in to the PowerTeacher Gradebook and been inactive for a 
length of time (typically 10 minutes), a dialog box asking for your password will open. 
Type your password, and you will be logged back in to your PowerTeacher 
Gradebook session. 

 
The PowerTeacher Gradebook Window 
By default, the PowerTeacher Gradebook opens to the Scoresheet tab, a modified 
spreadsheet through which you will track student assignment scores. A set of six icons 
is displayed near the top of the PowerTeacher Gradebook window: Scoresheet, 
Assignments, Students, Grade Setup, Class Info, and Reports. These icons will 
allow you to navigate through your gradebook. 
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displays the assignments and scores you have entered for the students 
 
 

displays the details of the assignments you have created 
 
 

 
contains demographic data for each of your students 
 
 
 

displays the final grade setup for each term 
 
 
 

contains the basic information about the selected course 
 
 
 

provides an interface through which you can designate how you want a 
   report to run 
 
 
 

 
Setting up the Gradebook 
The PowerTeacher Gradebook is configured for immediate use. If you want to practice 
using it without going through the setup process, you can -– it is fully functional. You 
can begin work as soon as the student roster appears in the gradebook. 
 
The default settings for the gradebook establish the final grade setup as being 
calculated on a total points basis, and establishes four types of assignment categories: 
Homework, Quiz, Test, and Project. 
 
However, if your personal preference or school policy dictate that you configure the 
gradebook in a particular way, you can follow the procedures outlined below to 
customize the gradebook. 
 
Setting Up Categories 
Categories are broad classifications in which similar types of assignments are grouped. 
Daily assignments, tests, and quizzes could each be set up as assignment categories. 
 
The PowerTeacher Gradebook comes with four pre-defined category types: Homework, 
Project, Quiz, and Test. You can add more categories and/or modify these as needed to 
meet the requirements of your class. 
 
When you create a category for your assignments you will define several pieces of 
information about the category: abbreviation, points possible, and score type. During the 
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term, when you create an assignment and choose a category, the category settings 
become the default for the assignment. This information can be modified as needed for 
each assignment.  
 
Score type indicates to PowerTeacher Gradebook how you would like scores displayed 
on the Scoresheet – as Points, Percentages, or Letter Grades. 
 
Note: Penmanship, Elementary MAPS classes, Elementary Homeroom, and 1st Grade 
Science and Social Studies will use Letter Grades. All others will use Points. 
 
Think ahead to how you expect to use your PowerTeacher Gradebook and then modify 
the Score Type for each category so that the PowerTeacher Gradebook is set up to 
best meet your needs. One principle that holds true is that keeping the score type for all 
categories the same is the simplest solution, both for entering scores and for 
interpreting the results. 
 
Creating a New Category 

 
 
 

• Click the Tools menu at the top of your screen, 
and select Categories 

 
 
 
 

 
 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

   
Do not delete a category after assignments have been created.   

 

 

 

 
 
 

• The Categories window will appear, displaying 
the pre-defined assignment categories. 
 

• Click the Plus (+) in the lower left-hand corner 
of the Categories window to add a new 
category. 

 
 

• Click the Minus (-) in the lower left-hand corner 
to remove a Category. 
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• You can continue to add categories by clicking the Plus sign, or you can modify an 

existing category by changing the default values in its fields. 
• When you have added all categories or completed making changes, click Close. 

The Categories will be saved. 
 

Note: These categories will be available to all of the classes or sections you teach. If 
you teach a variety of topics, each requiring different categories, use the categories you 
need. Unused categories have no impact on student assignment scores or final grades.  
 
 
Special notes for Elementary:  
 
** In ILA classes you will create categories titled READING, ENGLISH and SPELLING.  
Remember to set the Points Possible to 100 and the Score Type to points. 
 
** Elementary teachers will need to take into consideration that all categories are 
available for all classes. For example, the use of the category GRADES might only be 
used for subjects that have points possible of 100. Additional categories will need to be 
created for specifically for Penmanship (4pts. possible), Homeroom Conduct (4pts. 
possible), and 1st grade Science and Social Studies (2pts. possible).  
 
 

E 

B 
A 

G 

F 

D 

C 

A-Type the name you would like to use for 
the category 

B-Enter an abbreviation to stand for this 
category 

C-Choose the color you would like to use for 
the category on the Scoresheet 

D-If there is a typical number of points 
possible for the category, enter the points 
possible 

E-Choose the score type for the category 

F-Very Important! Select the checkbox if 
scores for assignments in this category are to 
be used in the calculation of the final grade 
for the course. 

G-Enter a description for the category. This 
description will be displayed in the 
Administrator and Parent Access areas of 
PowerSchool. 
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Setting Up Final Grade Weighting 
After you create assignment categories, you will need to determine how your students’ 
final grades will be calculated for each term. You have several options for final grade 
calculations: 
 

• Total points 
• Category weights 
• Term weights- used for Semester averages 

 
Total Points 
The Total Points option is the most straightforward method of calculating the final grade 
for the quarters. When you use this method, the student’s quarter grade will be 
calculated by dividing the points the student has accumulated by the number of points 
possible. 
 
Total Points is the default setting for all terms. If you need a different method, you will 
need to set up each class. 
 
Category Weights 
Another way to calculate the final grade is to use Category Weights. This method 
multiplies the total number of points by the value (or weight) of each category. 
 
This option should only be used at the quarter level. This method allows you to set up 
the weights for each category according to your personal plan or school policy. 
 
Regardless of how you choose to setup your final grade weight factors, it is best to 
establish your method before classes begin, and remain consistent throughout the term. 
Being consistent will help minimize confusion for parents and students as they monitor 
student progress using the Parent/Student Portal.  
 
As part of the Grade Setup, remember to: 

• Record the details of the setup so that you'll be able to recall and explain how the 
final grade is calculated. 

• Communicate how grades are calculated to students and parents. A good way to 
provide this type of information is to include it on the Class Info tab or as a 
Category Description. 
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Term Weights 
Term Weights will be used for Quarter and Semester averages. Term weights are established by 
SCS and are listed below. 

All schools   
Y1 = S1 is 50% and S2 is 50%. This term is for teacher information only. It is not used to award 
credit nor does it print on the report card. 
 
All High Schools  
S1- Q1 is 40%, Q2 is 40% and E1 is 20% 
S2- Q3 is 40%, Q4 is 40% and E2 is 20% 

First Semester HS Gateway courses 
S1- Q1 is 35%, Q2 is 35%, E1 is 15% and G1 is 15% 
 
High School course ending in a Gateway Exam, End of Course Test, or HS Writing Assessment 
S1- Q1 is 40%, Q2 is 40% and E1 is 20% 
S2- Q3 is 35%, Q4 is 35%, E2 is 15% and G2 is 15% 
 
Important Dates and Information for Exams, Gateway Exams and End of Course Tests 
S1 Gateway - 12/20/08 
S1 Exam – 12/22/08 
S2 Gateway/EOC – 5/28/09 
S2 Exam – 5/30/09 

Note:  
• If a student is exempt from the exam leave the score unrecorded. An unrecorded score will 

show in your grade book as a blank for a letter grade, a dash for percent and in the Parent 
Portal as a dash for the exam but will print on the report card as EX. This score will not be 
included in the calculation for the semester average. 

• If a student is absent on exam day, enter a 1 as their score. 

8th Grade Algebra and Physical Science 
S1- Q1 is 40%, Q2 is 40% and E1 is 20% 
S2- Q3 is 35%, Q4 is 35%, E2 is 15% and G2 is 15% 
 
8th Grade ILA Q4  
In Q4 the set up will be changed to 85% (total) from other categories and 15% from a single 
assignment – The Tennessee Writing Assessment. An assignment will be created called 
Tennessee Writing Assessment when scores are returned to the school. 
 
All Elementary and Middle classes other than Algebra I and Physical Science 
S1- Q1 is 50% and Q2 is 50% 
S2- Q3 is 50% and Q4 is 50% 
 
Elementary ILA 
Q1, Q2, and Q3 Integrated Language Arts- 50% Reading, 30% English and 20% Spelling. 
 
5th Grade ILA Q4 
In Q4 the set up will be changed to reflect 50% Reading, 25% English, 20% Spelling and 5% TN 
Writing Assessment. A category named TN Writing Assessment should be created at the start of 
Q4 and a single assignment titled Writing Assessment should be created when the scores are 
returned to the school. 
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Using Grade Setup 
Grade Setup determines how the PowerTeacher Gradebook calculates final grades. 
The final grade is calculated continuously throughout the term so that you and your 
students always know the final grade. 
 
Click the Grade Setup tab. 

• The main window of the PowerTeacher Gradebook is divided into two panes. 
The upper pane shows icons representing the years and terms as they were set 
up in PowerSchool. The lower pane contains a set of radio buttons you can 
select to determine the final grade setup. (Note: If you do not see the terms you 
wish to work with, select a different term from the pop-up menu above the class 
list on the left.) 

• Select a term to work with by clicking it in the upper pane. 
• Choose a method for final grade setup and refer to the table below to enter 

information in the fields: 
Final Grade Setup Method Information to Add 
Final Grade Setup 
Method 

Information to Add 

 
 
Total Points 

Choose whether you would like to drop low scores and the number 
of scores to drop. (Note: It is probably best to choose to drop a 
number of assignments after several have been created and 
scored. To do so too early may make it harder to interpret the final 
grade.) 

Category Weights When the Category weights option is selected, it is not terms, but 
assignment categories that appear in the table.  
 
Choose which categories to factor in the final grade by clicking 
“add category” on the left below the table the Select Categories 
window will appear. Select the checkbox for each category you 
want to factor in to the final grade calculation. All assignments that 
are in this category will be included in the final grade calculation – 
unless the “include in Final Grade” checkbox was left empty when 
you created or modified the category. (In that case, assignments in 
the “not counted” category will not figure in to the final grade 
calculation no matter how much weight you give it in the Final 
Grade Setup.) 

Term Weights – 
 
Note: Term 
Weights must be 
used at Semester 
Term level.  

When you select this option the dependent terms appear in the 
table in the lower half of the “Calculate final grade using:” pane. 
 
Click on one of the terms. Enter a whole number to represent the 
value each term is to have on the final grade. The percent will be 
calculated automatically. 
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Setting up Student Groups 
Teachers know that students arrive on the first day of school with different needs and 
readiness. Often, teachers use grouping techniques to help them increase their ability to 
adapt instruction to the particular needs of students. PowerTeacher Gradebook 
supports student grouping practices by providing tools for creating groups and choosing 
students to include in those groups. Because student needs change, student group 
assignments are flexible; they can be modified at any time. 
 
Definitions 

• Entire Class – default PowerTeacher Gradebook group 
• Set – a collection of groups.  For example, Math. You must create the Set before  

you can create a Group. 
• Group – a small collection of students, For example, Math1, Math2, Math3 or 

Bluebirds and Redbirds. 
 

 
Creating a Set and Groups 

 
 

 
 

 
 
 
Note: Reports will run for the entire class until you set up student groups. A student 
must be in a group before he or she can be selected for individual reporting. 
 
Adding Students to a Group 

• Click the Students tab, and click on a student’s name. 
• Drag the name of the student to the appropriate group. 
• Add students to each of the groups you created. Notice that you cannot add a 

student to more than one group within a set, but you can add them to more 
than one group if the groups are in different sets. 

• When you click on the name of a group, the names of the students in the 
group are highlighted in the main window. 

• You can delete a student from a group by clicking the student’s name in the 
group list, then clicking the Minus (-) at the bottom-left corner of the 
PowerTeacher Gradebook window. 

 

• Click the Students tab 
• Click the Plus (+) in the lower left 

hand corner 
• PowerTeacher Gradebook will 

automatically create Untitled Set 1 
and Untitled Group 

• Double-click Untitled Set 1 and 
enter a name for the Set, such as 
Reading 

• Press the Enter key 
• Double-click Untitled Group 1 and 

enter a name for the Group, such as 
Early Readers.  

• Press the Enter key 
• Click the Plus (+) again and click 

Group 
• Enter a name for your group and 

press the Enter key 
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Moving Students Between Groups 
A student cannot be in more than one group of a set, but you can transfer a student 
from one group to another. 
• Click the arrow to the left of the group name to open the group and display the 

names of the students in that group. 
• Click the name of the student you would like to move and drag it to the folder for 

one of the other groups. 
 
Setting PowerTeacher Gradebook Preferences 
 

 

Viewing Gradescales 
The gradescale is determinded b SCS policy. To view the grade scale: 

• Click the Tools menu, and click Gradescales. 
• The appropriate gradescale will display in a floating window. 

 
Class Info 
The Class Info tab contains basic information about the course you selected in the 
Classes pane. You can enter text in the Description field to communicate with parents 
about class rules and your expectations of students, give an overview of the course and 
any other information that would be of interest to parents. In this tab you can enter 
custom names for each class. Example: Smith’s Math. 
 

• Click the Class Info tab at the top of the screen. 

• Click the PowerTeacher Gradebook menu at 
the top of the screen, and select Preferences. 
The Preferences window will open to the 
Grading tab. 
• Choose “Rounded” and select to calculate 

grade up to 0 decimal placed.  
• Select the method of Final Grade Display. 
• Click OK.  
 

 

!

!

 

• Click the Section tab. 
• Determine the display method for 

classes on the spreadsheet. 

Note: Teachers that have multiple 
sections of the same subject can 
choose Custom Display Name and 
rename the sections. 
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• In the Description box, type the information you would like parents to be able to 
view. 

• In the Custom Display Name field enter the information to identify this class. This 
is for your information and will not display on the Parent Portal.  

 

       
 

• Click Add Web Link to add a link to a web site that would be helpful to parents 
(such as a page displaying the school's Internet policy). For ease of use it is 
recommended that you select the option to “Open this link in a new browser 
window”. 

    
 
Assignments 
Some teachers enter new assignments when they are ready to record the scores for 
that assignment; others enter new assignments when the assignment is given to the 
students; and still others like to set assignments up at the beginning of a school term. 
Whenever you add assignments and save your data, the new assignment information 
can be made available to parents or guardians and students immediately if you choose. 
 
After each assignment is created in the Assignment tab, it will show up in the 
Scoresheet. The name, point value, and date due for each assignment appear above 
the column in which you will enter student scores. Double-clicking the assignment 
heading (or clicking the arrow at the top) will take you back to the assignment page 
where you can modify the assignment or publish criteria. 
 
As you enter assignments into PowerTeacher Gradebook, you will notice a demarcation 
line that indicates where future assignments are located versus past assignments. This 
will help orient you on your spreadsheet, and keep you from scrolling forward to future 
assignments each time you open your gradebook. 
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Entering assignments as they are given to students helps to facilitate home/school 
communication. If you assign a large project to your students that will be due in one 
month, you can enter this assignment into your gradebook as soon as you announce it. 
You can enter an assignment description, along with the due date and the total points 
possible, so parents or guardians can monitor their student’s progress on the 
assignment. Students can monitor missed assignments themselves by logging in to 
PowerSchool.  
 
Having assignments posted before entering scores does not skew how grades appear. 
The Final Grade that appears next to the student’s name on the Scoresheet reflects an 
average grade for only the assignments that have already been entered. 
 
Creating an Assignment 
• Click the Plus (+) sign next to the Assignment header at the top of the Scoresheet 

to open the New Assignment pane. (Or in the Assignment tab, click the plus sign 
on the left beneath the list of assignments.) The New Assignment pane will open in 
the lower half of the window. 

 
Refer to the table below as you enter information into the fields: 

 Field Name Information to Add 

A Name Provide the assignment title. Assignment names can not be 
duplicated nor can the assignment name be the same as the 
category name. 

B Abbreviation The abbreviation will be auto-filled with the name of the 
assignment. You can change the abbreviation to something that 
makes sense to you 

 
C 

Category Assign a category to the assignment from the list of categories 
created previously. If the assignment does not fit into any of the 
categories create a new one-just take care to not overdo it! Too 
many categories can become cumbersome. Limiting the number 
of categories you have to less than ten is probably a good idea. 

D 
 

Score Type PowerTeacher Gradebook automatically displays the score type 
you selected for this category. You can change the score type, if 
desired. Remember the advantages of being consistent in how 
you represent student scores. It’s hard to compare unlike values. 
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E Points Possible PowerTeacher Gradebook automatically fills in the default value 
you designated for this category. You can change this value by 
entering a different number of points. 

F Weight 
 

The weight of the assignment should remain on the default of “1”. 
A good rule of thumb is that if the assignment is to count more 
toward the final grade, make the assignment worth more points. 

G Due Date Enter the date the assignment was collected.  The default due 
date for assignments is the date of entry. 

H Include in Final 
Grade 

A checkmark must be in the box in order for the assignment to 
count toward the final grade.  

I Description Enter a general description and specific instructions for the 
assignment. Try to be clear enough that students who missed 
school the day the assignment was given can complete the work 
when they return, without a lot of explanation from you. If you 
would like to have students use the Internet as part of the 
assignment, you can link to online resources by using this HTML 
code: 
 
<a href=enter web address here target=_blank>click here</a> 
 
EXAMPLE 
<a href=http://www.scsk12.org target=_blank>click here</a> 

  
• Click Save in the lower right corner to save the assignment. The assignment will 

appear in the Scoresheet. Details about the assignment will appear in the column 
heading for the assignment. 

 
Note: Remember to click the plus sign time each time you are creating a new 
assignment. When you are creating several assignments in a row, you cannot simply fill 
in the fields with new information and save. Doing so would overwrite the existing 
assignment. 

 
Note: To delete an assignment, highlight the assignment you would like to delete by 
clicking on its heading, and click the Minus (-) next to the assignment header area. A 
dialog box will appear asking if you really want to delete the assignment. A similar 
dialog box appears if you have already entered scores for the assignment. Be very 
careful about deleting assignments; this action cannot be undone. 
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Publishing Assignments 
Publishing the assignment makes it possible for parents and students to see it in 
PowerSchool Parent Access. You can publish an assignment at the same time you are 
creating it, or at any point afterward. 

• Click the Publish tab in the assignment pane. 
 

• PowerTeacher Gradebook defaults to publishing assignments to the Parent 
Portal as soon as they are created. If an assignment is part of the student’s 
final grade, it must be published at some point to the Parent Portal. You will 
receive an error message if you choose the "Never" publish option for an 
assignment that is to count toward the final grade. 

• Refer to the table below as you enter information into the fields: Consider 
when you want parents and students to know about the assignment and when 
you want students to be able to begin work. Sometimes you'll want to publish 
the assignment long before it is due. 

• Once students have completed the assignment and you have entered scores, 
you can return to this part of PowerTeacher Gradebook to publish scores. 
Note that parents can see only their own child's scores and students can see 
only their own scores. 

• Click Save.  
 Field Name Information to Add 

A Publish Assignment Choose whether you want to Publish Immediately, On a 
Specific Date, or Days Before Due 

B On Date Choose the date you want the assignment published 
C Days Before Due Choose the number of days before the assignment is 

due that you want the assignment published. 
D Publish Scores Place a checkmark in this box if you would also like to 

publish the scores for the assignment 
E Save Details about publishing to the Parent Portal will appear 

in the heading of the assignment on the Scoresheet. A 
blue circle with an hourglass will indicate that you 
chose to publish the assignment at some time other 
than "Immediately." A circle with a line through it 
indicates that the assignment will never be published. 
An exclamation point indicates the scores will not be 
published. 

 
 
Copying Assignments 
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If you teach multiple sections of the same course, and assignments are the same 
across sections, you can copy assignments from one class to others within the current 
term. 

 
• Create the assignment in one section of the course. 
• Control-click the assignment, and click Copy Assignment. Or, click the Tools 

menu, and select Copy Assignment. 
 

 
• In the Copy Assignment dialog box, place a checkmark next to the names of the 

classes you would like to copy the assignment to. 
• Click OK . 

 
 

 
 
 
 
Recording Scores 
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After you collect and grade an assignment, enter the scores the students earned on the 
Scoresheet. 
• Click the Scoresheet tab. 
• Click in the cell representing the intersection of the row containing a student’s name 

and the column of the assignment you want to score. 
• Enter scores that match the type of score you set up when you created the 

assignment; numbers for points and percentage, letters for letter grades. If you 
would like to mark an assignment Exempt, type EX into the cell on the spreadsheet. 

• Press Return (Mac) to advance to the next student, or Tab to advance to the next 
assignment. 

• When you have finished entering scores, click Save. 
• In the event that you accidentally overwrite scores by entering values in the wrong 

assignment column, click Revert. 
 

Fill Scores 
If a majority of the students in your class got the same score on an assignment, you can 
use the Fill Scores tool to quickly enter student scores. 
• Click the Scoresheet tab. 
• Ctrl-click the assignment details in the column heading, and select Fill Scores. Or, 

click the Tools menu, and select Fill Scores. 
• Choose to Fill Empty Scores for the assignment, or to Replace All Scores for the 

assignment. 
• Mark the assignment Collected, Late, Exempt, or enter the Score for the 

assignment. 
• Click OK. 

 
Editing a Score 
Change a score you entered earlier. 
• Click the score, drag over it to highlight it and type the new score, or delete it and 

enter a new score. 
• The score will appear highlighted in gray until you click Save to save the changes 

you have made. 
• Make changes as needed. Click Save. 

Making changes in the score type will cause PowerTeacher Gradebook to convert the 
scores you entered automatically. Making changes affects the display of scores, but not 
their value. The final grades are not changed. 
 
 
 
 
 
 
 
 
 
 
 
 
Changing Points Possible 
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Occasionally you will create an assignment and set the points possible, then determine 
that the actual assignment has a different number of points possible. Perhaps the 
assignment you originally envisioned was different from the actual assignment. For 
example, imagine that you created an assignment in PowerTeacher Gradebook worth 
100 points, but scored student work based on a maximum total points possible of 50. 
You would need to change the points possible for the assignment. 
• Open the Assignment Detail pane of an assignment that has already been scored 

by clicking Expand at the top of the assignment’s column heading in the 
Scoresheet. 

• Change the value in the Points Possible field to 50 and click Save. 
• As soon as you click Save, a warning will appear. If you know the scores you have 

entered are correct and do not need to be changed, click OK. 
 
Using the Score Inspector 
The Score Inspector is a tool in PowerTeacher Gradebook that provides the ability to 
note if an assignment was received late, if a student is exempt from completing the 
assignment, and even that you’ve collected the assignment without entering a point 
value. You can also use this tool to enter a score comment. 
 

• Click the Tools menu and click Score Inspector. (Or Ctrl-clicking a score also 
makes the Score Inspector available.) The Score Inspector will appear as a 
floating window that you can move around the screen. 

 
 

• Click a cell in the assignment column on the Scoresheet for the student you wish 

 
 

 -When you check the Collected box in the Score 
Inspector, a checkmark will appear in the 
Scoresheet for the student. 
 
-When you check the Late box, a small red L will 
appear in the Scoresheet for the student. 
 
-When you check the Exempt Score box, a gray Ex 
will appear in the Scoresheet for the student. 
 
-When you check the Missing box, a brown M will 
appear in the Scoresheet for the student. 
 
-When you enter a score comment, a small blue C 
will appear in the Scoresheet for the student. 
Clicking the Comment Bank will provide you with a 
list of district comments that can be inserted for a 
score. 
 
-Assignment score comments appear in 
PowerSchool Parent Access when the user clicks 
Grades and Attendance, then on a term grade, and 
finally on the number representing an assignment 
score. 
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to work with. 
• Choose a comment or hold down the  key and choose multiple comments. 
• Click Insert Selected Comments and click OK. 
• The Clear button on the Score Inspector clears the score completely, not just the 

comment or a Collected check or Late indicator. 
• You can use the four directional arrows in the Score Inspector to move through 

the Scoresheet without closing the Score Inspector. This enables you to adjust 
scores, add comments, and add collected, late, and exempt notes to scores for 
all the students in your class without having to click each student one by one. 

• Click Save at the bottom of the Scoresheet to retain changes. 

 
 
Legend for PowerTeacher Score Indicators 

 Indicator Description Indicator Meaning 
A Small “c” in blue dot next to score There is a comment attached 
B Small “L” in red dot next to score Assignment turned in late 
C Green check in a cell Assignment turned in but not graded 
 
D 

 
Italicized faint score 

Assignment does not count toward final 
grade OR was marked as exempt after 
scoring. (If marked Exempt with no 
score, Ex appears in gray) 

E Small Hourglass in assignment heading Assignment published on certain date 
F Circle with line through it in assignment 

heading 
Assignment is never to be published 

G Small red exclamation mark next to 
italicized final grade 

Final grade changed by manual 
override 

H “M” in brown dot in the scoresheet Missing score 
 
 
Manually Override a Final Grade 
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Occasionally, teachers will want to modify a student’s final grade in a course – based on 
effort, participation, or other classroom factors. This function will be used for all Honors, 
AP, and IB classes to adjust the final grade and percent. The Score Inspector allows 
you to change a final grade with the Manual Override tool. 

• Highlight the Student’s Name or the Final Grade cell to the right of the student’s 
name. 

• Click the Tools menu, and click Score Inspector. 
• Place a checkmark in the box next to Manual Override 

  
 
 
 
 
 
 
 
  

• Once you check the Manual Override box, the Grade and Percent boxes become 
available. Change the contents of each of these boxes making sure that the 
information in the grade and the percent match. 

• Add a comment manually, or from the comment bank if needed. 
• Final Score comments appear in PowerSchool Parent Access when a user clicks 

on the Grades and Attendance tab, then on a final term grade. The Final Score 
Comment displays as the Teacher Comments on the Class Score Detail Page. 

• Close the Score Inspector window. Once the grade is changed manually, it is 
displayed in italics on the Scoresheet. Also, a red exclamation point (!) is placed 
in the Final Grade cell indicating that you made a manual change to the student’s 
final grade. 

• Click Save in the lower right corner of the Scoresheet to save your changes.  
 

Output – Scoresheet, Statistics, and Reports 
Once you have entered your assignments and the resulting scores into the 
PowerTeacher Gradebook, you have a variety of ways to view the scores. 
 
Filter the Scoresheet Display by Term, Category or Students 
After using the PowerTeacher Gradebook for some time, you may have created and 
scored many assignments for each class – more assignments than will fit on your 
computer screen. When you launch PowerTeacher Gradebook, the Scoresheet 
automatically opens displaying the first few assignments you created with later 
assignments visible only when you drag the scrollbar at the bottom of the pane to the 
right. 

• Filter by Reporting Term – The menu on the left filters the assignments by 
reporting term. Your PowerSchool administrator determines the setup of the 
years and terms at your school. Choosing a term or a portion of a term (week or 
month) will determine which assignments are displayed. Assignments with due 
dates falling between the start and end dates for the term (or time period) you 
select will appear in the Scoresheet. 
 

• Filtering by Category – The category menu will allow you to choose to limit the 
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display of assignments to one category. The default display is ALL. Open the 
Category menu to see all of the categories you have created. Filtering by 
categories is one way to get a sense of how students are doing on that type of 
assignment. 

• Filter by Students – You can filter your spreadsheet to show only students who 
are active in the class, those who have dropped the class. The spreadsheet 
defaults to active students. 

 
Filter assignments by using the drop down menus that appear between the navigation 
bar at the top of the PowerTeacher Gradebook window and the assignment heading. 

 
Note: When you have a filter in place on your spreadsheet, and switch between 
classes, the filter will carry over to the next class you view so that you see the same 
term, category and group of students (active vs. dropped). 
 
Assignment Statistics 
PowerTeacher Gradebook provides you with tools to view trends and to analyze your 
students’ scores mathematically. Assignment statistics provide information on each 
assignment you enter into the gradebook. 
 
To view the Statistics Summary, click Summary in the lower left corner of the 
Scoresheet to see the mean, median, and mode values for each assignment. 

• The mean is the mathematical average of the scores you entered. 
• The median represents the middle of all values: one-half of the scores will    

be above this number and one-half will be below it. 
• The mode indicates the most common value. 
 

PowerTeacher Gradebook Reports 
The reports available through PowerTeacher Gradebook allow you to have a paper or 
electronic copy of information to show the principal or a parent. There are seven types 
of reports available, and they can be presented in three output types: 

• PDF – a cross-platform file that can be read and printed by Adobe Acrobat 
Reader or Preview  

• HTML – a file that can be read by a browser such as Internet Explorer, Firefox, or 
Safari. 

• Text Export (csv) – a text file consisting of the data, separated by commas. This 
file can be opened with Excel or another spreadsheet software application. 

To use the available reports, Click the Reports and select the type of report you would 
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like to view. 
• Attendance Grid Report – can be used to take attendance at field trips or other out 

of classroom events. It can also be used as a convenient roster for note taking 
during student presentations, or to track class participation. The date range displays 
a five week span on a single page. 

• Category Total Report – a summary of the assignment category totals for each 
reporting term grouped by student and class. This report shows graphs for 
assignment count and average score per category. 

• Final Grade and Comment Verification – a report showing final grades and 
teacher comments for students grouped first by section, then by term. 

• Individual Student Report – a report that lists section scores by assignment, and 
the final grade for each reporting term, listed in a one page per student layout.  

• Missing Assignment – a report that lists assignments that are missing per 
assignment or per student.  

• Scoresheet – allows you to view final grades for all reporting terms along with 
assignments that are within a specific date range, for all students. 

• Student Roster – a report that allows you to specify which columns of student data 
to list on the report, and in what order, each time the report run. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• Click the Output Option you would like (PDF, HTML, or CSV). 
• Select the appropriate sections, students, and date range for the report. 
• Click Run Report in the lower right corner of the screen. 
• The report will be saved in the file type and location you choose on your computer. 

 
Note: In order to run a report for selected or individual students, you must first add 
students to groups.  
 
 
 
 
 
School Reports in PowerTeacher 

 
 
 
 
 
Options for 
configuring the 
report appear in the 
lower pane. 
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Your school determines what reports can be printed from the PowerTeacher Portal. 
These reports may include form letters, progress reports, and report cards. For 
information about custom reports your school has created, see your PowerSchool 
administrator. 
• Click the printer icon on the same row as the class for which you want to print a 

school created report.  
 

 
• Click the desired report from the "Which report would you like to print?" menu. 
• Check Test print? to verify the report before printing. 
• Use the Watermark Text pop-up menu to if you would like to print “Confidential,” 

“Draft,” or another word in a faint color on the report. 
• If you want the report to print right away, leave the When to print menu as the 

default, ASAP. Otherwise, enter a date and time in the boxes provided. 
• Click Submit. 
• When you run a report in PowerTeacher, the Report Queue – My Jobs page 

appears. 
• Verify the status of your report. If your report is still running, click the word Refresh 

in blue in the upper left corner of the screen to update the queue. Do not click your  
browser’s Refresh button. 

 
 
 
 
 
 
 
 

 
 
 
• When your report shows that it has been completed in the Status column, click 

Completed to view the report.  
• To print the report, click File, then Print. 
 
School, Teacher, and Parent Communication 
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Parents can keep track of upcoming school events, view student progress, and can 
communicate with teachers through PowerSchool Parent Access. 
 
School to Parent Communication 
Using PowerSchool Parent Access, parents can view the School Bulletin. This activity 
facilitates the flow of information between the school and the parent. 
• The School Bulletin displays the public version of daily announcements. Parents 

have the opportunity to read about upcoming events, school announcements, and 
new opportunities that affect their child. As a result, parents don’t have to rely 
entirely on their child bringing the information home. 

 
Teacher to Parent Communication 
Parents and Teachers can use PowerSchool Parent Access as a communication tool. 
• The easiest method for parents to communicate with teachers is to click the 

teacher’s name on the Start Page of PowerSchool Parent Access and send the 
teacher an email. 

• Parents can read certain teacher comments by clicking the Teacher Comment icon. 
These teacher comments reflect the student’s performance in the class as a whole, 
not on a specific assignment or test. The comments that appear here are entered via 
the Teacher Comments student screen in the PowerTeacher Portal. 

 
Staying Connected: Subscriptions and Email 
Parents can register to receive updated information by email. 
• Email Notification – Parents can keep in touch with their child's class progress and 

upcoming school events by registering to receive Email Notifications. Most of the 
information parents will receive with the Email Notification is available in other 
locations on the Parent Access site, but it is often easier for parents to receive 
information via email rather than visiting the site. This information is automatically 
sent from PowerSchool to the requested email addresses according to the schedule 
the parent chooses. 

• My Calendars – Parents and students can subscribe to a teacher’s or the school’s 
published calendar using the My Calendars feature. This feature can be used with 
Macs or PCs with any electronic calendaring software that uses the iCalendar 
standard. As part of the subscription process, parents can name the calendar and 
determine how often it is refreshed. Once the parent has subscribed, the class 
calendar shows up in the list of calendars to which he or she has previously 
subscribed or has created. Parents can also subscribe to the school’s published 
calendar so that Daily Bulletin items will display in their calendaring software. 

 

 

 

 


